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I. A Quick Tour of F9

A Quick Tour for F9

This is a short tutorial designed to familiarize you with the basic concepts of creating financial reports with
F9. Every F9 financial report starts as a spreadsheet and uses the features of Microsoft Excel 2007 and F9

Version 5.

For this reason you will also find Excel's online Help to be an invaluable aid when you create your financial

reports. To find complete information about any F9 feature,r e f e r

t -ine HeYpdos mooerdetails.

Where there are differences between Excel 2007 and 2010, separate instructions and screenshots will be

listed.

1. Getting Started

1. Open Excel and ensure F9 is attached.

There should be an F9 tab to select within the Excel Ribbon:

Excel 2010:
@l = k= Microsoft Excel = = £
Home Insert Fage Layout Formulas Data Review View Fg - The Financial Reporter & e
§+l_| @’_i i j—': 55 Chart =,7 [EHraReport Controls - EE F9 Lists 55 F9 Setup ~ 2 F9 Help
I : =/ .
' @B Budget Writeback | — @Zero Suppress = % FE Maintenance ﬁjFQAdd—in Options | 7= About F9
Report Inguire Table Fivot Table - Drrill _
Wizard and Paste Report Report L Analyze Down g’a Fublish F9 = E Migrate Fovd.x [EE] License Manager -
F& Reporting F2 Analysis . F2 Tools _ Preferences Help
I
Excel 2007:
. r : B i
( 3 \ = Microsoft Excel - = X
—/ Home Insert Page Layout Formulas Data Review View Fa - The Financial Reporter '@)
3 [ o= > Chart =7 3 F3 Report Controls - | EE FA Lists 33 F9 Setup - 2 F9 Hel
8[| als Bt AN
- @B Budget Writeback | — @Zero Suppress * % FE Maintenance [[“’;]FQAdd-in Options | P2 About F9
Report  Inguire Table PivotTable - Crill ) ) _
Wizard and Paste | Report  Report () Analyze Down Qa Publish F2 - ;% Migrate FOv4 x [EF] License Manager ~
F9 Reporting (P F2 Analysis (P F9 Tools (F] Preferences Help

If the F9 Ribbon is not present, please refer to Installation and Setup instructions installed in the F9 folder

called: F9 Readme for (your product).PDF.
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2. Ensure that you have a blank workbook open.

Excel 2010:
.
To open a blank workbook, choose the File Tab , New, Blank Workbook, and Create.
[z“ H -
Home Insert Page Layout Formulas
H Save
Available Templates
Save As
E3 Open {3 Home
' Close . l|
Ve T ™
Info l/’.‘
Recent Blank Recent

workbook templates

Cffice.com Templates
Print o—" EE'
Save & Send . - \

Agendas Budgets

Excel 2007: _
Ca
To open a blank workbook, choose the Office Button “~* , New, Blank and recent, and Create.
= R R

J Templates

Paste I Elank and recent l
Installed Templates Blank and recent

; My templates...

Mew from existing...

Microsoft Office Online

Featured lank Workboo

Agendas
Budgets

Calendars
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3. Ensure Calculation in Excel is set to Manual.
This allows users the most control on when F9 results will be refreshed.

Excel 2010:

Fil
Select the File Tab , Options, Formulas and click Manual as shown:

Excel Options

General "ﬁi " . .

‘—‘ﬁ Change options related to formula calculation,

[ Formulas l

Proofing Calculation options

Save Warkbook Calculation

1 Automatic
Language () Automatic except for data tables
Advanced @ Manual
Recalculate workbook before saving
Customize Ribbon

Excel 2007:

(Ba
Select the Office Button “* , Excel Options, Formulas and click Manual as shown:

Excel Options

Popular "ﬁ o d .
P '—‘_‘ﬂ Change options related to formula calculation,
[' Formulas -l

Proafing Calculation options
Save Workbook Calculation G

{} Automatic
Advanced {} Automatic except for data tables
Customize @' Manual

|:| Recalculate workbook before saving

Add-Ins

With Manual Calculation, you can calculate an entire workbook (or all open workbooks) by pressing the F9
key. Shift+F9 is used to calculate the active visible worksheet and F2+Enter calculates just the active cell.
To save you time, all F9 reports should be created with Excel set to Manual Calculation so that the entire
workbook does not recalculate every time you edit a cell.
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4. Next, ensure F9 is setup to access the Demo company data with name 99 and continue with this
quick tour. Select from the F9 Ribbon F9 Setup. If you do not see 99 in the Company dropdown,
select Change Server and select server where your accounting data is installed.

F9 Setup [Sage PRO ERP'] @

System: |CADATAMGAGE PRO 20104 Brawse
Compary: |99 Professional Software, Ine. j Compary Profile

Budget: |BUD_DEF = | ~Famatting
Period: | Off - “Yaar | 2008 - Zero Label |0
Scaling |Mone -

[v Return Zera for Accounts Mat Found
[ Accumulate lncome Walues Rounding: |Mone :|v

[ Enable Automatic D ataPreload

Financial Entities Setup »» | ] | Cancel | Help |

5. For more information on the data F9 accesses for your accounting system, refer to the Information

section within Fo6HelpHen the FoRibbane 7 FHER g
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2. Quick Trial Balance

1. F9 can quickly output your Chart of Accounts and period values in a variety of ways. To begin, select
from the F9 Ribbon, F9 Table. A F9 task pane will display to the right of the active worksheet. Hover
the mouse on the task paneds | ef drseledtheddeopdovtneontdol ag t he

at the top of the task pane and Size to control the display and docking.

F9 Table hd

Source l Move

Size

Compan

Igg— Close

Budgets: Years:

[Bun_CEF w2008
- ;

2.  Within the tab: F9 Table, set the F9 dropdowns to output the entire Chart of Accounts by typing an *
in each account part; select Company SAMLTD , 1, 2010 and January:

F9 Table v x

source | options |

Companies: 7
jos []
Budgets: Years:

|BUD_DEF j |2-:u:-8 j

Period:
|Janl.|a|'~' j
[~ UseWhole Account

Acct:

j [~
Dep:

j [
Prod:

j [~

Accounts:
Find | r

3. Next select tab: Options.

e F9 Chart: select Include Account Code, Description and Account Origin
e Output: select F9 Classic Chart, Values, New Sheet
e Formatting: select Add Total Row
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4. Click on the Find button at the bottom of the F9 Table task pane to see the results output in a new

worksheet. The columns will be sized to display your information and should like similar to the
following:

A B C D E
1
2 |Companies 99
3 Years 2008
4 |Budgets BUD_DEF
5
6 |Accounts:  (*)(*)(*)
7
8 Periods January
9
10 Account Description Origin Amount January
11 '11010-000-0000 Cash in Banks (System Checking) Balance Sheet 3,468,441.59
12 "11011-000-0000 Cash in Banks (Manual Checking) Balance Sheet 14,250.47
13 '11020-000-0000 Petty Cash Balance Sheet 2,500.00
14 '11025-000-0000 Marketable Securities - Trading Securities Balance Sheet 0.00
15 "11030-000-0000 Accounts Receivable Balance Sheet 1,176,183.04
16 '11040-000-0000 Allowance for Doubtful Accounts Balance Sheet 0.00
17 '11050-000-0000 Inventory (Finished Goods) Balance Sheet 1,102,205.75
18 '11051-000-0000 Inventory (Materials) Balance Sheet 0.00
19 '11052-000-0000 Mon-stock Inventory - Miscellaneous Balance Sheet 0.00
20 "11053-000-0000 Inventory (Scrap) Balance Sheet 0.00
21 '11054-000-0000 Overhead Balance Sheet 0.00
22 '11060-000-0000 Mfg. (Rounding/Variance) Balance Sheet 0.00
23 "11080-000-0000 IC Clearing (Finished Goods) Balance Sheet 0.00
24 '11081-000-0000 IC Clearing (Materials) Balance Sheet 0.00

5. As atrial balance, we should ensure the total for the period totals zero. We set F9 Table to create the

subtotal formula within the Options tab and we can scroll to the end of the report or a faster technique
is to use the keyboard End key:

a. Click on any cell in column E with a value.
b. Click the End keyboard key and then the down arrow key.
c. Excel should bring you to the end of the report in column G.

The last cell should contain al=SUMBEOSET gndig BN as:)
iﬁ -5.3558E-10!

To improve the format of this cell, select the Excel Home tab and within the group Number the
comma option:

General <
$ - % % 5%

Mumber £l

The value in the trial balance total should now display as: |j| To return to the top of the
report, click at the same time: Ctrl + Home from the keyboard.

for mul

-

C
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7. Notice the current report contains accounts with zero amounts. One way to not display these rows is
to use the F9 Zero Suppress command. First, select the range of information to suppress i one way
is to highlight the entire column E. Click the F9 Ribbon tab and within group F9 Tools, select Zero
Suppress and then Zero Suppress Rows from the dropdown.

@ Zero Suppress ™ :&'j
Qﬁ Zero Suppress All
g Zero Suppress Rows

J]j' Zero Suppress Columns
Undo Zero Suppress

The F9 report should now display just rows with amounts. Notice the rows with zeros have been
hidden in Excel. To redisplay the rows at any time, simply highlight the area and select Undo Zero
Suppress.

8. Rename the worksheet containing the F9 trial balance report to: Trial Balance 1.
[ Oa
9. Save the workbook as F9 Tour.xIsx by selecting the Excel button *~* , Save As, Excel Workbook.

Notice the default extension in Excel 2007 is now .xIsx; this means the file is stored in XML format
which will be approximately 60 per cent smaller in size from the same report saved as an .xls file,
which is Excel s previous binary output.

There are many other benefits to saving Excel files to the new XML format such as improved stability
of files with less chance of corruption issues; in addition, Excel6 XML can be extended by other
applications programmatically and is the industry standard for web-based communications.

3. A More Dynamic Trial Balance

In the first example, F9 Table output the most basic report with just values in the rows and one subtotal at
the end. Next, we will generate the same report with dynamic report controls and F9 formulas to return
descriptions and values across all account rows.

1. First, we will ensure F9 is setup to create report dropdown controls. From the F9 tab, group Options,

select F9 Add-in Options [fF2 reainOstions| Engre Create F9 Report Controls is selected and hit
OK. We will see how this works with a new report created by F9 Table.

k=9 Addin Options

[v Always Calculate Fundions

|¥ CreateF3 ReportControls

[~ SupportMultiple Topics onSharePoint

Function Timeout

Color5cheme
f¢ Auto (" Blue (" Silver (" Black

oK | Cancel |

2. Back to the F9 Table task pane, we will make just one change within the Options tab:
e Output: select F9 Classic Chart, GL Formulas, New Sheet
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3. Click on the Find button at the bottom of the F9 Table task pane to see the results output in a new

worksheet.
A B C D E

1
2 Companies 99
3 Years IEDDS .l =
4 Budgets BUD_DEF
5
6 Accounts:  (*)(*}(¥)
7
3 Periods January
9
10 Account Description Origin Amount January
11 '11010-000-0000 Cash in Banks (System Checking) Balance Sheet 3,468,441.59
12 '11011-000-0000 Cash in Banks (Manual Checking) Balance Sheet 14,250.47
13 '11020-000-0000 Petty Cash Balance Sheet 2,500.00
14 "11025-000-0000 Marketable Securities - Trading Securities Balance Sheet 0.00
15 '11030-000-0000 Accounts Receivable Balance Sheet 1,176,183.04
16 '11040-000-0000 Allowance for Doubtful Accounts Balance Sheet 0.00
17 '11050-000-0000 Inventory (Finished Goods) Balance Sheet 1,102,205.75
18 '11051-000-0000 Inventory (Materials) Balance Sheet 0.00
19 '11052-000-0000 Mon-stock Inventory - Miscellaneous Balance Sheet 0.00
20 '11053-000-0000 Inventory (Scrap) Balance Sheet 0.00
21 '11054-000-0000 Overhead Balance Sheet 0.00
22 '11060-000-0000 Mfg. (Rounding/Variance) Balance Sheet 0.00
23 '11080-000-0000 IC Clearing (Finished Goods) Balance Sheet 0.00
24 '11081-000-0000 IC Clearing (Materials) Balance Sheet 0.00

4. There are two differences in this report.:

First, F9 report dropdown controls are created for easy selection.

e Change the year to 2009 and click Shift-F9 to recalculate the trial balance; values for all
account rows update automatically. How this is done is with F9 formulas that are based
on a number of different filters and parameters.

e Change the period in column E to February and recalculate again. F9 recognizes
accounting like phrases to retrieve period balances.

The second and most significant change is that F9 formulas have been written to control the
results returned for all rows with accounts. This makes the report dynamic; change a reporting
filter such as Type and values change with recalculation; post transactions to the GL and
recalculate an F9 report to see new values automatically. No recreation of your report required.

e Edit the account specifier in cell B11; change it from: 11010-000-0000 to: 11*-*-*, Click
Shift-F9 to see the new period total for the account grouping. This is one example of how
to combine multiple criteria within F9 formulas.

e Delete the rows of accounts we just combined. Highlight the 3 entire rows below the new
account and right-click to Delete. Your trial balance total should once again be zero as
expected.

e Save this worksheet tab as: Trial Balance 2 and save your entire workbook also.

Now that we have created a more dynamic Trial Balance report that can recalculate with different results
when a report filter such as the Period changes, we will want to start learning the how F9 formulas work
to create flexible reports of any nature.
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I[I. The Fundamental F9 Formula

The GL Function is the fundamental F9 formula as it links any cell in your spreadsheet to any balance in
your general ledger. This is accomplished with a set of parameters that tell F9 what balance you would
like returned. The syntax of the GL formula is:

=GL(Account, Period, Company, Year, Type, Currency)

Where:
Account is the GL account(s) specifier
Period is the fiscal period(s)
Company is one or more company specifiers
Year is the specific fiscal year
Type is the actual or budget type
Currency is the currency type (if supported in your accounting system)

Write this formula down; in fact write it down twice, as it is the core of all F9 Reports.
The GL formula does not require all 6 parameters, so if your accounting system does not support
currencies, you do not need to enter this specifier.

In many instances you will want your balances to be returned as negative values. To do this, simply use
the= N GL ( fuéction in place of the GL function. The parameters of the NGL function are identical to
the GL function.

1. The GL Formula

1. Open the F9 Tour workbook, and select the Trial Balance 1 worksheet tab.
2. Unhide the zero suppressed rows to work with all accounts. Select the entire worksheet by
clicking on the upper left corner:

5] F9 Tour.xls:
A

o

Next, from the F9 tab, select Zero Suppress and Undo Zero Suppress.

3. Cell E11 should contain your first period amount. Click on cell E11 and you will see that although
there is a value in this cell, there is no formula. The true strength of F9 is rooted in F9 formulas
and the ability of all spreadsheets to use absolute and relative cell references so that they can
turn on a single cell.

4. In cell E11 type the GL formula, substituting the appropriate cell reference for each parameter of
the GL formula. In the example below, as in your sheet, the GL Formula will be:

=GL(B11,E8,B2,B3,B4)
Where:
B18 is the Account number
E11l is the Period
B2 is the Company
B3 is the Year
B4 is the Type
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A B - D E F G
1
2 |Companig99
3 Years 2008
4 |Budgets |BUD_DEF
5
6 |Accounts: (*){*)(*)
o
8 Periods
9
10 Account Description Origin Amount January
11 111010-000-0000 | Cash in Banks (System Checking) Balance Sheet [=GL($B11ES8,5852,$BS3,5854)

ENSURE THAT YOUR CELL REFERENCES ARE CORRECT and press F2+Enter to calculate the cell. If
the formula is correct, the cell will return the same value, but it will now be based on an F9 formula.

As you will notice, none of the other values below cell E11 have changed. This is because they are not
formula based. Don't worry, though; you do not have to type the GL formula again if you use the correct
Absolute and Relative cell references and Auto-Fill.

e Absolute and Relative Cell Referencing

By default, a formula you create in Excel uses Relative cell references. This means that if you copy a
formula, Excel will automatically adjust the cell references in the copied formula to refer to different cells,
relative to the position of the original formula. So, if we copy this formula from cell E11 to cell E12, all row
references will change by one row. This formula would then be: =GL(B12,E8,B2,B3,B4)

In the new formula, the Account specifier (B11) is correct, but the Period specifier is now cell (E8), which
is obviously not correct. In fact, the Company (B3), and Year (B4) are also incorrect now. To copy this
formula correctly, we will have to ensure that Excel does not adjust the cell references when we copy the
formula. This is called an Absolute reference and is accomplished by placing a dollar sign ($) before the
parts of the reference that should not change.

1. Click oncell E11, and in the formula bar (located at the top of the spreadsheet, above the column
names) move your cursor to the beginning of the Account reference (B11).

[=6L($B11,E38, 852,383, 5854)

2. Press F4. Each time you press F4, Excel toggles through the combinations: absolute column and
absolute row ($B$11), relative column and absolute row (B$11), absolute column and relative row
($B11), and relative column and relative row (B11). We will want the Account reference to change
as we copy down rows (relative, no $), but not across columns (absolute, $). Press F4 until the
Account reference is $B11. You can also add the $ symbol with the keyboard.

3. We will not want the Period reference to change as we copy it down rows, but we will across
columns (relative column and absolute row). Make the Period reference E$11.

4. The Company, Year, Type, Structure Code, Currency and Functional Currency cell references

should not change when we copy the formula down or across the report, so make both the
column and row references absolute as: $B$2, $B$3, $B$4.

10
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5. Press Enter to complete formula edit.

The formula should now be: =GL($B11,E$8,$B$2,$B$3,$B$4) and is ready to be copied down all of the
account numbers.

e Auto-Fill

1. Before we copy the new F9 formula to all the rows below, go to the last row and insert a blank
row between the Total and the last account. We will see why this is required once the Excel Auto-
Fill completes. Select Ctrl-Home to return to the top of the report.

2. Click on the cell with our first GL formula, (E11). You will see a fill handle which is located at the
bottom right of the cell when it is selected. Move your mouse over the fill handle, and your pointer
will become a crosshair.

———1

Fll Fandia

3. Double click the fill handle. The formula will now copy down all rows that have an adjacent value
in Column D. If there is no value in Column D, or if your version of Excel does not support this
feature, simply drag the formula down by clicking and holding the left mouse button over the fill
handle and dragging the formula until the last row with an account number is selected.

4. Click on any cell in your spreadsheet. You will notice that all of the cells have the same value as
cell E11. This is because the sheet is set for manual calculation. Press F9 to calculate the
workbook, and the values from your GL will populate the report.

2. Description Formulas

We will now want to make the descriptions in this report formula-based so that when you edit an account
number it will return the appropriate description.

In F9 there are two formulas for returning account descriptions, these are the =DESC Function and
=SDESC Function. DESC returns the account description for the full account code. If the DESC function
is used on a range or list of accounts, it returns the description for the first account found in the range or
list. SDESC produces the descriptions associated with the individual segments of the account code. In
short, the DESC is used to return the Natural Account description and SDESC is used to return the Sub-
Account description.

a. The DESC Function

The syntax of this formula is the similar to the GL function with less specifiers:

=DESC(Account, Company)

Where:
Account is the GL account(s) specifier
Company s the specific company

11
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b. The SDESC Function

The syntax of this formula is:

=SDESC(Segment, Segment Number, Company)

Where:
Segment is the GL segment specifier
Segment No is the segment position
Company is the specific company

Segment Number always contains the number of the segment you wish a description for. The first
segmentis "1."

Make the descriptions in this report formula based

1.

2.

3.

4.

5.

Make cell C11 active and ensure its format in Excel is General. Right-click and select Format
Cellsé Click on category General and hit OKk.
In C11, enter the =DESC formula, referencing the appropriate cells for each parameter
[=DESC(Account, Company)]. Press Enter and recalculate this cell (F2 + Enter). If the description
is not returned ensure that your formula is correct i.e. =DESC(B11, B2).

Give the parameters in this formula the correct absolute and relative cell referencing. The DESC
function should now be defined as: =DESC($B11, $B$2).

Copy the formula down using Auto-Fill so that it covers all accounts. Ensure that you entered the
correct absolute and relative cell referencing and recalculate the current sheet (Shift +F9).

Save the workbook file.

The F9 report now recalculates dynamically and contains formulas to return period balances and account
descriptions. If you look at tab: Trial Balance 2, you can compare the formulas F9 created automatically
from F9 Table with Output as Formulas i they should look identical.

12
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F9 Reports

1. Report Creation with GL Paste

F9 can generate a properly formatted GL function easily for you via the Inquire and GL Paste command.
GL Paste is useful if you need to create reports with specific segment filters or groupings such as by
Segmentl as well as a good first step to creating your own formatted report with the most flexibility.

GL Paste creates the first GL formula in a new worksheet along with all required parameters properly
referenced with the correct absolute and relative cell referencing.

1
2.
3.
4

5.

Click on the Sheet 1 Tab and rename this sheet to: GL Paste.

If the F9 Table task pane is displayed, close this first.

From the F9 ribbon, choose Inquire and GL Paste. This will open the F9 Inquire task pane.
For settings, set to:

Company: 99

Type: BUD_DEF
Year: 2008

Acct: type 1*
Dep: type *
Prod: type *

Next, select Get Balance to review the total for accounts 1*-*-*:

F9 Account Inquire v X
Companies: hrd
o -
Budgets: Years:
|BUD_DEF j |2.;..;.g j
Periods:
|['.'1a|'ch j
Acct:

- [
Dep:

j [
Prod:

j [

Balance:

888241341 Get Balancel
Create GL Function by:
m GL Paste |
[~ ReverseSign [v NewSheet

13
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6. Next, we will paste F9 formulas to the active worksheet. Set the active cell to A1 as GL Paste will
start at the current active cell.

7. From the F9 Inquire tab, click the GL Paste button. You will see the beginnings of a new report
with F9 report dropdown controls, a GL formula properly parameterized and also a DESC formula
written to return account descriptions.

A B C D E F
1
2 |Dep: *
3 |Prod: *
4
5 |Companies: 99 oa
6 Years: 2008
7 |Budgets: BUD_DEF
8 IMarch _Iv
9
10 |1* Cash in Banks (System Checking) 8,882,413.41
11

8. Place your cell pointer on the period January. Notice it is also a F9 dropdown control and
contains many of the typical period specifiers F9 recognizes. Drag this control across to 2 more
columns 1 the month automatically changes for you and the dropdown control is also retained.

March April IMEE _| -

9. Select the cell with the account description and notice a =DESC( ) was written.

10. Select the cell with the GL amount. Change the name of the F9 formula to =NGL to have F9
return the amount as a positive amount. Notice this GL formula contains one additional
enhancement, the F9 BSPEC( ) function which stands for Build Specifier.

|=NGL|:BSF‘ECI:5&18.5852.5853].E58.EEEB.EE-EE.SBS?]

11. BSPEC is used to separate the full account into separate segments to be filtered in your F9
reports. For example, you may need to return balances for a list of Segments as opposed to just
one or all. BSPEC makes combining segment groupings and filters easy. An example will
illustrate this further:

a) Goto cell B3 and select Prod 1000. Hit F9 to recalculate and note a new amount
returned.

b) Go to cell B3 and instead of selecting from the dropdown either type for its value:
@000,1000, or do the right click and from the Right click menu select F9 Control List. In
the F9 Control List window select both values 0000 and 1000. Hit F9 to recalculate again.

c) Setthe active cell to the period amount returned and select Drilldown from either F9
Ribbon or the Right click menu. Select different Drill By criteria and hit the Drill button to
view the different results. Click on any cell in Excel to return to the report.

12. Next, we will expand the report created by GL Paste by adding more rows.

14



2. Lists

A Quick Tour for F9

The primary role of the Lists feature is to save time manually entering data that already exists in your GL.

The List feature typically allows you to enumerate:

Segments (used most often)

Companies

Budgets

Lists

Periods

Years

From the F9 Ribbon, click on Lists; |58 F Lists

Select Segments under Available Lists.
¢ Inthe List Segment drop-down, select Account
e Inthe Where drop-down, select Account
¢ Inthe Is field, type *

Ensure Generate Descriptions is unchecked

window.

F9 Lists [Sage PRO ERP ] X

Available Lizts

* Segments  Lists
" Companies { Periods
(" Budgetz  { “ears

Lizt Segment:

|.-’-‘u:c:t j

Wihere: I

|[None) | [11010;Cash InBa |

[ Tranzpose List?
[v Generate Descriptions?
-

Send To Clipboard | Ef |
Help

Next, we will want to paste this into the sheet and finish the report.

=

ok wn

Hit F9 to recalculate the new results.

Click Send To Clipboard, press OK to the List was Sent To Clipboard message, and Quit the Lists

Select the cell that contains your first account number (Cell A10) and select Paste (Edit | Paste).
This will paste in all Accounts within the range.

Click on the GL formula in E10 and drag it to the other columns F10 and G10.

Next click on the cell with the description, E10 and highlight cells: E10 to G10.

Using your mouse, drag the selection down rows with accounts.

Auto-Fit the description column if necessary to expand its width for display and save the report.

15
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Dep:
Prod:

Years:

(= T =< T N I R Y I S R Y N By

[
[=]

11010
11011
11020
11030
11050

TR R
[REQ = B

Companies: 99

Budgets:

March April

May

-3,950,711.65 -3,950,711.65
-4,652.86 -4,652.86
-2,500.00 -2,500.00

-1,142,520.11 -1,142,520.11

-1,395,886.79 -1,395,886.79

-3,950,711.65
-4,652.86
-2,500.00

-1,142,520.11

-1,395,886.79

You can use the features of Excel and F9 to make this report exactly how you wish. Add sum formulas,
change single account specifiers to ranges, add a variance column to compare the current year versus
the past year, make graphs and charts. These are all benefits of creating your financial reports with F9
directly within a spreadsheet application as powerful as Excel.
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3. F9 Report Wizard

A Quick Tour for F9

Report Wizard is available to step users through defining report dimensions such as: rows, columns, and
the control area, and writes a fully completed F9 report with dropdown controls and F9 formulas for you.

Select or change any of the dropdown controls to calculate new results easily. The initial report can be
expanded upon since F9 formulas are written with the correct cell referencing for all parameters.

Create an Actual versus Budget Report:

1.

wn

No

8.

9.

Select Sheet 2 as the active worksheet and close the Inquire task pane, if open.

&

From the F9 Ribbon, select Report Wizard: e

Resize the Report Wizard task pane to increase its display by dragging its border on the left

towards the active worksheet.

Pick -1 for Company and hit next.
For the Row axis, select Account in the upper window. Next, highlight all accounts that start with
4* and hit the >> button to move to the selected window.
Select Total and >>. Hit Next.

For the Column axis: select Periods in the upper window. Select Description and >> to move to

the selected window. For Periods, select This Month and >> and then This Month Budget and >>.
Select Variance and >>. Hit Next.

For the remaining axis, select Year 2008, Type BUD_DEF and type in value * for both the Dep

and Prod. Hit Next.
Under Format, enter a title such as: Actual vs. Budget Report.
10. Select checkbox to reverse the sign,
11. Choose the conditional formatting output and Finish.
12. Use Auto-fit to resize the columns.

41000
41030
41040
41030
42000
42010
42020
42030
42040
42050
42060
42070
42080
42090
Total

Actual vs. Budget Report

Description

This Month This Month Budget Variance

Sales - Miscellaneous
Returns and Allowances
Sales Discounts

Payment Discounts

Sales Labor JC
Sales_Material JC
Sales_Subcontractor JC
Sales_Equipment IC
Sales Overhead JC

Sales Other Charges JC
Sales_Material Markup_IC
Sales_Subcontractor Markup_IC
Sales_Freight_JC
Sales_Discount_JC

[8881,350.08 IS1,325,000.00 | -443519.92

I $0.00 [ ($2,000.00) | 2000
Kiz13,457.42) | ¢5,700.00 [ -19187.42
I $0.00 | 45,000.00 | -5000
| $0.00 | $0.00 | 0
I $0.00 [ 50.00 | 0
I 30.00 | 50.00 | 0
| $0.00 | $0.00 | 0
I 40.00 | 50,00 | 0
I 40.00 | 50,00 | 0
| s0.00 | $0.00 | 0
| s0.00 | $0.00 | 0
| s0.00 | $0.00 | 0
I $0.00 [ $0.00 | 0
$867,892.66 $1,333,700.00 ($465,807.34)

Rename the tab to: Report Wizard and save the report.
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4. F9 Sales Report with Filtering

The next example will create a F9 report in the form of a dynamic Excel 2007 table with filtering. Tables in
Excel 2007 offer many new advantages including dynamic formatting, formulas, filtering of one or more
columns to collapse and expand information, as well conditional formatting and KPls.

F9 Table creates financial table reports for enhanced analysis and business intelligence.

1. From the F9 Table Report task pane, select the F9 Table tab.
a. For the Division, type: 1* and other segments: *.
b. For Period select: January, Type BUD_DEF, Year 2008
2. Select the Options tab and change:

a. F9 Chart: Include Account segments, check Segments in Separate Column
b. Output: unselect Classic Chart, Paste as GL Formulas
c. Formatting: Add Data Bar, Table style: Light 11 (green)

3. Click on the Find button at the bottom of the F9 Table task pane to see the results output in a
new worksheet.

A B £ D E F G
1
2 |Companies 99
3 |Years 2008
4 Budgets BUD_DEF
5
6 |Accounts: (*}*)*)
o
8
9
10 w7 =2 w7 w7 =2 w7
11 '11010 '000  '0000  Cash in Banks (System Checking) Balance Sheet [-3,468,441.59
12 '11011 '000  '0000  Cash in Banks (Manual Checking) Balance Sheet I -14,250.47
13 '11020 '000 '0000  Petty Cash Balance Sheet | -2,500.00
14 '11025 ‘000 '0000  Marketable Securities - Trading Securities Balance Sheet | 0.00/
15 11030 '000 '0000  Accounts Receivable Balance Sheet |—1,1?6,183.M
16 '11040 ‘000 ‘0000  Allowance for Doubtful Accounts Balance Sheet | 0.00
17 11050 ‘000 '0000  Inventory (Finished Goods) Balance Sheet |—1,102,205.?5
18 '11051 '000  '0000  Inventory (Materials) Balance Sheet | 0.00/
19 '11052 ‘000 '0000 Non-stock Inventory - Miscellaneous Balance Sheet | 0.00
20 '11053 ‘000  '0000  Inventory (Scrap) Balance Sheet | 0.00/
21 '11054 ‘000 ‘0000 Overhead Balance Sheet | 0.00
22 '11060 ‘000  '0000  Mfg. (Rounding/Variance) Balance Sheet | 0.00/
23 '11080 '000  '0000 IC Clearing (Finished Goods) Balance Sheet | 0.00/
24 '11081 '000  '0000 IC Clearing (Materials) Balance Sheet | 0.00/

Notice the amounts are negative i this can be quickly changed by going to the first cell with an amount
and editing the formula.

1. Gotocell G11.
2. Hitthe F2 key to edit the formula.
3. Change =GL to =NGL and hit Enter.

All formulas below the first in the F9 table are automatically changed. This is one of the advantages of
Tables in that Excel provides extra intelligence to manage its own content.

Filtering:

Notice there are a number of rows with all zeros. Within Tables, one can filter on different criteria over one
or more columns very easily.
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1. Incolumn G, select the down arrow at the cell that displays its heading, January.

2. Un
A

A

o 4

W

check the last item for zero values (0)

Sort Smallest to Largest

Sort Largest to Smallest

Sort by Color 4
Clear Filtgr From “Amount January
Filter by \%ar 4

Number Filters 4

-] -180.00
v -150.00
-[]0.00

v 0.20

~[#] 10181
~[¥] 33104
-] 549,67 =

[ I Y —

i

[ OK J[ Cancel J

Note a filter icon displays to the right of January to indicate a filter is active for this column.

A | 8 [ c|op| E L F | & |

[Ble|s|e|=|~|o]|n]|=

Budgets BUD _DEF

Accounts:  (*)(*)(*)

At B Dep Brod B Description v Origin B Amount JarEd
‘11010 '000 '0000  Cash in Banks (System Checking) Balance Sheet |-3,4E-8,441.59
11011 '000  '0000  Cash in Banks (Manual Checking) Balance Sheet . -14,250.47

Another filter might be to display certain Segments. Click on the dropdown for Prod and select just
Segment 1000,2000, and 3000. The report will now display the subset requested.
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Budgets

10
35
96
97
100
101
113
114
115
141
142
144
145
155
238

A

4
2
6 |Accounts: (*H*}*)
7
3
9

B
BUD_DEF

'41000
'41000
'41000
‘41000
'41000
'41040
'41040
'41040
'51000
'51000
'51000
'51000
'52050
Total

‘010
'010
'010
‘020
'020
'010
‘010
'010
‘010
‘010
‘020
‘020
'010

‘1000
'2000
'3000
1000
'2000
'1000
'2000
'3000
‘1000
'2000
'1000
‘2000
'1000

Sales -
Sales -
Sales -
Sales -
Sales -

Domestic - Hardware
Domestic - Software
Domestic - Service
International - Hardware
International - Software

Sales Discounts - Domestic - Hardware

Sales Discounts - Domestic - Software

Sales Discounts - Domestic - Service

Cost of Goods Sold - Domestic - Hardware

Cost of Goods Sold - Domestic - Software

Cost of Goods Sold - International - Hardware
Cost of Goods Sold - International - Software
Purchases Discount Taken

Rename the tab to Sales Report and save the workbook.

Because the contents of the table report contains F9 formulas, the financial information returned is

/L
p/L
P/L
P/L
p/L
P/L
p/L
p/L
P/L
p/L
P/L
/L
p/L

A Quick Tour for F9

-0
149,679.50
528,998.60

30,750.00
126,703.85
216,498.80

-3,562.42

-9,250.00

-675.00
-84,878.10
-368,240.00
-72,662.35
~160,820.00
3,619.58

-5.91626E-10,

dynamic and you can select or change the F9 control area and recalculate for new reports. In addition, it
is possible to expand on the table with new columns for additional periods, for example.

Custom filters can be created to track values or results for a specific business need. Experiment with F9
Table to view different types of results and explore more into the new functionality for Excel 2007 tables.

5. F9 Pivot Table Report

The next example will create an F9 report in the form of a dynamic Excel 2007 pivot table. Pivot Tables in

Excel 2007 offer many new advantages including dynamic formatting, formulas, filtering of one or more

columns to collapse and expand information, as well conditional formatting and KPlIs.

F9 Pivot Table Report creates financial pivot table reports for enhanced analysis and business

intelligence.

1. From the F9 Pivot task pane, select the Source tab i this tab basically describes what data to
populate the Pivot table with.
a.

C.

For Years check both 2007 and 2008.
b. Forthe Account, type:*, and other segments: *.
For Period select: January
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F9 Pivok v X

Source l Options ]

Companies: ?
v
X
Budgets: Years:
VEIEEM 0% =
BUD_DEFA v 2007
I v
Period:
|Janl.|ar\,' ﬂ
[~ Use Whole Account
Acct:
I []
Dep:
I []
Prod:
I []

Create Pivot Table |

2. Select the Options tab i this is used to provide more detail on how the Pivot table content will be
managed:

a. Check Segments in Separate Columns

b. Inthe Create supporting amounts as: dropdown select NGL Formulas
c. Check: AutoFit Pivot Table Columns

d. Check: Recalc/Refresh in Manual
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Fa Pivot - x
Source Options

v Segments inSeparate Columns
[ Include Description

[ Incude Account Origin

[~ Prependth count Code a'
[~ Skip Accounts Showing all Zeros

Create supporting amounts as:

Mal Formulas ﬂ

Destination:
(v MewSheet

i~ CursorPosition

[W AutoFit Pivot Table Columns

v Recalc/Refresh in Manual

Create Pivot Table |

Click on the Create Pivot Table button at the bottom of the F9 Pivot task pane to have an initial
Pivot Table report generated.

To calculate values, click anywhere inside the Pivot report and then right-mouse click and select
Refresh.

The results should look similar to:
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